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Overview

Overview
This document describes the tools and functions that let you modify existing drawings.
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Editing Objects

Editing Objects
In this chapter, we shall look at the tools and functions that let you modify existing drawings.
All of the functions apply to the selected object or group of objects. The selected object
differentiates itself from any others by small colored squares or circles located around the
object (this is also true when several objects are selected simultaneously). In the rest of this
document, we call these points handles.
These handles form a rectangular frame that is just big enough to contain the object. Where
several objects are selected, the frame around them corresponds to the smallest rectangle that
can contain all of the objects. This frame is called the selection rectangle.
If the Option Bar is displayed, it is possible to change the size of the handles using two
buttons: 'Simple Handles' shows the handles as flat squares, and 'Large Handles' shows the
handles in a larger size. You can combine the effects obtained by pressing on both buttons.
You can thus have large handles having a 3-D shape or small handles having no 3-D shape.
This illustration shows the location of the handles and other buttons:
Simple
handles

Edit Points

Large
handles

Rotation Mode after
Clicking Object

Selection modes
There are three selection modes.
Selections used to move or change size are indicated by small green squares. This is the
default selection mode when the Edit Points button is not pressed.

Selections for rotating objects are indicated by small red circles and a symbol representing
the center of rotation.
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Selections for the Edit Points mode are indicated by blue squares. An extra, larger handle
also appears on most drawings. When the Edit Points button is pressed, this is the default
mode.

The default mode for selecting objects is set by the activation or deactivation of the Edit
Points button .
Changing the selection mode

To go from one mode to another, you can do the following:
Choose the Edit Points button
from the Options Bar to switch from simple selection
mode to Edit Points mode. You can also use the keyboard shortcut F81 (Edit Points).
Press the Rotate button from the Main Toolbar
selected object.

to activate the rotation mode for a

By choosing the Rotation Mode after Clicking Object button
from the Options Bar,
you can cycle through normal and rotation modes just by clicking on the object. This
could be more convenient than clicking the object, then clicking the Rotate button from
the Main Toolbar.

Selecting Objects
Direct selection

To select an object, the easiest way is to click directly on it. For objects that are not filled,
you have to click directly on the object's outline to select it.
Selection by framing

You can select several objects by dragging a large rectangle
around the objects with the select button:
For an object to be selected, it must be entirely within the
rectangle.

1 Keyboard shortcuts can be configured by the user (Tools > Configure > Keyboard).
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Selecting hidden objects

When objects are located behind others, they can still be selected. To select an object that is
covered by another object, hold down Alt and click the object. To select an object that is
covered by several objects, hold down Alt and click through the objects until you reach the
required underlying object. To cycle through the objects in reverse order, hold down
Alt+Shift when you click.
There may be some variation in the use of the Alt key on different operating
systems. For example, in my Linux system, the Alt key does not function as
described here.
To select an object that is covered by another object using the keyboard, press Tab to cycle
through the objects. To cycle through the objects in reverse order, press Shift+Tab.
The easiest method is to use the Tab key to cycle through the objects, stopping at the object
you wish to select. (This may not be practical if you have a large number of objects in your
drawing.) When you click on your selected object, its outline will appear briefly through the
objects on top of the selected object.
In the illustration below, the square located beneath the circle was selected in this way (the
circle was made transparent in order to see the square):

Arranging objects

In a complex drawing, you may have objects stacked up, one on top of the other. You can
rearrange stacked objects by clicking Modify > Arrange and selecting the appropriate Bring
Forward or Send Back options, or by right-clicking the object and picking Arrange from the
context menu. A keyboard shortcut is Shift+Ctrl ++ to bring an object to the top, and
Shift+Ctrl+− to send an object to the bottom.
Selecting several objects

In order to select or deselect several objects one by one, press the Shift key and click on the
various objects to be selected or deselected.
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Moving and Dynamically Adjusting the Size of an
Object
There are several ways of moving or changing the size of an object. The method described
here will be called dynamic in the sense that it is carried out using the mouse.
When you dynamically change an object, remember to check the left hand area of the status
bar at the bottom of your screen. This shows detailed information about the ongoing
manipulation. For example, during a resizing manipulation, you will see the following
information displayed:

The information displayed changes when the mouse is moved.
Dynamic movement of objects

To move an object, select it and then click within the selection frame and hold down the left
mouse button while moving the mouse. In order to drop the object at its new location, let go
of the mouse button. During movement, the shape of the object appears as dotted lines to
help with repositioning.

Dynamic size modification of objects

In order to change the size of an object (or group of selected objects) with the mouse, you
need to move one of the handles located around the selection. As shown in the following
illustration, the outline of the resulting new object appears as a dotted line.

The results will differ depending on which handle you use. If you choose a corner handle
you will resize the object along two axes at the same time. If, on the other hand, you use a
side handle the objects will only be resized along one axis.
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Note: If you press the Shift key at the same time as you carry out the resizing
operation, the size change will be carried out symmetrically with respect to the
two axes, which enables you to keep the height/length ratio of the object. With
the Alt key, the object is resized symmetrically starting from its center.

Rotating an Object
Rotation of an object lets you slant an object along an axis. In order to do this dynamically,
you use the red handles, as with changing the size of the object.
Rotation works in a slightly different way for 3-D objects (since the rotation occurs in 3D
space and not in one plane).
To rotate an object (or a group of objects), drag the red corner handle points of the selection
with the mouse. The mouse cursor takes the shape of an arc of a circle with two arrows at
each end. As with the preceding operations, a dotted outline of the object being rotated
appears and the current angle of rotation is dynamically shown in the status bar.
Rotations are made about an axis which is displayed as a small symbol. You can move the
axis of rotation with the mouse, as shown below:

Axis of
rotation

If you hold down the Shift key during the rotation, the operation will be carried out in
increments of 15°.
Inclination

To incline or slant an object, use the red handles located on one of the edges of the selected
object. The inclination axis is shown as the nearest handle to the opposite edge:
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This operation functions in the same manner as rotation in that you can set the inclination to
occur as steps of 15° by pressing the Shift key during movement of the handle.

Editing Object Points
Draw offers a complete set of tools that let you accurately edit the contour of an object. As
we shall see, the functions related to editing points work substantially in the same way as on
curves. To make the most of these tools, you'll have to convert your objects into curves, as
will be described later on.
Direct operation

Some objects can be manipulated in 'Edit Points' mode without having to convert them into
curves. When you do this you act directly on the properties of the object. The objects
involved are defined by the presence of one or more extra handle points. When you
manipulate this handle (which is generally larger in size than the other selection handles), you
will obtain various effects. The mouse cursor takes the shape of a folded hand when it passes
over one of these points. Here is the complete list of the objects concerned.
Rectangle or square.
In this example, you can make
the corners more or less rounded.
Figure 1 - Simple Rectangle

Figure 2 - Rounded Rectangle

Arcs or ellipses.
In this example, you can change
the associated angles. Arcs have
two control handles.

Figure 3 - Pie

Figure 4 - Moving control
points in the pie

Figure 5 - Circular
Segment

Figure 6 - Moving
control points of the
segment

Circular or elliptical segments.
In this example, you can change
the position of the edge of the
segment.
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How curves work

Editing curves works on the basis of a method called Bezier curves2. The complete study of
such curves goes beyond this particular work. We shall cover the basics of this quite
powerful method of editing the contour of an object.

figure 7 - Definition of a
tangent

Editing a point in a Bezier curve uses several mechanisms as
represented in the drawing on the left: The main point is
called the junction point. Two tangents project from this
point, enabling manipulation of the curve that passes through
the junction point. The basic idea is that, around the junction
point, the two sides of the curve 'flatten' out more or less
along the tangent depending upon the size and position of the
tangent.

You can create all manner of shapes by moving either the junction point itself, or one or both
of the round handle points at either end of the tangent.
The Bezier Curve Toolbar

When you work in edit point mode, the object bar changes as shown in Figure 8.

Figure 8 - Edit Points Toolbar

On this toolbar, some buttons can be pressed or not. Their behavior is then different. The role
of the three buttons enabling you to choose the type of tangent will be described in the
following chapter. They are the sixth, seventh, and eighth buttons in the toolbar. The
functioning of the other remaining buttons will be described in relation to working examples.
The three kinds of tangent

Three buttons in the toolbar let you select the type of tangent and convert from one type to
another. Only one of these buttons can be depressed at any given time.

Figure 9 - Symmetrical
Definition

The
button lets you work with a symmetrical tangent. Any
movement of one or the other of the handles will be carried
over symmetrically to the other one.

The
button lets you separate the lengths of the two parts of
a tangent. In the drawing opposite, you can clearly see that the
Figure 10 -

2 Bezier curves were invented by Pierre Bézier, an engineer working with the Renault car manufacturer, who
developed the technique in the 1960s. The technology was intended to make modeling the surface of vehicles
easier.
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curve is flatter on the longest side of the tangent. This kind of
tangent is known as a smooth junction. This button is not to
be confused with the preceding one, since their
representations are fairly similar.

Figure 11 - Inflexion
Point

It is also possible to completely detach both sides of the
tangent. In this case, the central point is known as the
inflexion point. Using this technique, you can draw spikes and
troughs in objects. Use the
button to create an inflexion
point around the selected point.

Examples

The following examples start from a filled circle. As mentioned earlier, in order to use the
Edit Points mode, you need to convert the object to a curve. This can be done on the selected
object by clicking the right mouse button or by choosing Modify >Convert > To Curve
from the Menu Bar.
You will notice that after conversion, the handles located in the corners of the rectangle have
disappeared. This behavior is normal in that the handles which are used in Edit Points mode
are located along the trace of the drawn object.
The Move Points mode is the default mode when editing
points. If it hasn't been activated, click on the button. When
this mode is active, the mouse cursor has the following shape
when it is hovered over an edit point:

Movement of the junction point is one of the easiest
manipulations to do. The drawing opposite illustrates how an
egg can be drawn very easily by starting from a circle and
dragging the the top edit point upwards.
Figure 12 - Moving a junction point
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To change the location of the tangents, just move the circular
handles at each end. The mouse cursor will then look like
this:

Figure 13 - Rotating a tangent

This button lets you add an extra point to an existing
curve. Just click with the left mouse button on the curve at
the spot where you want to insert a point and then move the
mouse slightly, in any direction, while holding down the
button. If you just click, the new point will not be added.
The tangent attributes that are associated with the new point
will depend on the buttons that are pressed in the toolbar.

Figure 14 - Adding an edit point to
a curve
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➊

This button has the opposite effect: it subtracts one or
more points from the curve. The resulting curve will stretch
itself automatically around the remaining points after
subtraction.
Firstly, select one or more points to delete.
You can select several points by holding down the Shift key
(➊).
Then click on the
button. The selected points disappear
from the curve that will then reform around the remaining
points (➋).

➋

Note: You can also delete the selected points using the Del key on
your keyboard.

Figure 15 - Deleting points from a
curve

The object rotation button
can be used in Edit Point mode.
In this case, it can be used to move a point around the contour
of an object.
Switch into rotation mode by clicking on the
button. You
will notice that in rotation mode, all of the tangent points
become red dots.

➋

Select the point to be moved and then drag it around the
contour while keeping the left mouse button pressed down
(➊). When you let go of the mouse button, the point will be
moved to the new position (➋).
If you move one of the handles located at the end of the
tangents during rotation, you will make the object rotate in
exactly the same way as with the usual rotation operations.

Figure 16 - Moving a point
on a curve
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This button lets you cut a curve at the height of the
selected handle. If the object is filled, it will be emptied
insofar as the curve that represented the edge is no longer
closed.
Check that you have selected the correct handle (➊), press on
the
button (➋) and notice that the object is no longer
filled. You can then check by moving the point, that the curve
has indeed been separated (➌).
Note: if you have an open curve, the start point of the curve is
larger than the others.



Figure 17 - Slicing a curve

You can also separate a curve at several points
simultaneously. Just keep the Shift key pressed down and
select all of the points at which the cut should occur.

Figure 18 - Moving a segment
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The
button lets you close an existing curve. Select an open
curve and click on this icon to close it.

Figure 19 - Closing an open
curve

The Select Points
follows.

button functions as a switch. It works as

If you have two points linked together by a straight line (you
don't need to have a curve between the points) and you insert
a new point between them that is set at an angle to the initial
straight line (and hence the two endpoints), you will have a
drawing similar to that illustrated in ➊.
If the Select Points switch is deactivated, and you move the
point you've just inserted, to bring it back close to its initial
position in the straight line, you will have a drawing similar to
that illustrated in ➋.

Figure 20 - Using the
'select points' switch
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If the switch is activated, moving the point back towards the
axis of the initial straight line will cause the line to snap into
place and the new point will be hidden from view (as
illustrated in ➌). The new point will not have physically
disappeared however, and you can bring it back into view by
just dragging the mouse cursor (represented by a cross-hair)
away from the axis of the straight line.
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